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= 1. Introduction

CastPodder is Linux Podcast receiver. You can use it to Subscribe to Podcast's, receive them and
listen to them on your computer or portable audio player.

With CastPodder you can easily Subscribe to your favourite Podcast feeds, or any Podcast you find
on the Internet. 

You can have CastPodder make periodic checks for new episodes, or even schedule a time for
checking yourself. Bringing you always the freshest Podcast's as they are made available,
CastPodder makes it easy for you to organize and synchronize content.

This User Guide will introduce you to the basics of CastPodder, and will help you to better enjoy
your experience with it.

= 2. Getting Started

To begin receiving the Podcast shows of your choice, you need to download and install CastPodder
on your computer.

To download the latest version of the CastPodder software, please visit the website, at:
http://www.castpodder.net

== 2.1 Requirements

CastPodder requires the following in order to work properly in your system. Make sure your system
meets the minimum requirements before you install the software.

Software
Operating Systems: Linux (Posix)
Audio Playback: XMMS or Beep-Media-Player

Hardware
Free Disk Space: 100 MB
RAM: 256 MB

== 2.2 Installation

Depending on what you downloaded:
 tar -jxf CastPodder-version.tar.bz2; cd to castpodder then ./install.sh
 rpm -iUhv CastPodder-version.2006.0mdk.noarch.rpm
 dpkg -i castpodder_version_all.deb

== 2.3 Starting CastPodder

You can easily start CastPodder by clicking on the CastPodder shortcut located in the Start ->
Multimedia -> Sound -> CastPodder.

Next versions of CastPodder will be located in Start -> Internet -> News

A splash screen featuring the CastPodder logo will appear and the software will appear on your
screen.
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= 3. The User Interface

The CastPodder User Interface is organized in Tabs. There Tabs provide one-click access to
different sets of information and control tools over the CastPodder software. The next few pages
will introduce you to this environment and will guide you into gaining absolute control over your
Podcasting experience.

== 3.1 Downloads

First Tab from the right is Downloads. Here CastPodder lists the various Podcast episodes you may
be downloading at any given time. Separate types of information are provided on 6 different
columns, while information on each download is grouped in a row.

In the Downloads Tab, you can see the Podcast episode's Name, State, Progress, Date, Playlist
association and Location on the Internet.

In addition, the Tab's Status Bar displays information as to how many downloads are in progress,
and the upload/download speed of the files. In the Status Bar of the window, live information on
what CastPodder is currently doing and what it results to are provided (Such as scanning a number
of feeds).

You can select items in the Download tab by clicking on them (Select multiple items by holding
down the Ctrl or Shift keys), and then Remove or Cancel them with the red "x" and "–" buttons.
You can even search the Download List by entering search terms in the available text box next to
these buttons and pressing the "Enter" button.

Removing a download from the Downloads Tab will not delete the downloaded or partially
downloaded file from your computer. To do this you need to use the Cleanup Tab.

If you right click on a Download from the list, you will see a pop-up menu with the options to play
an Episode in your chosen Player software, remove the download from the list with "Clear selected
items", or check any available information on it with "Show Notes".

== 3.2 Subscriptions

The Subscriptions Tab is key to the CastPodder application. It allows you to manage everything
about your subscriptions to Podcast's. Here you can add a Podcast's Feed, check it, and begin
receiving content. Every Podcast you add is displayed in the Subscriptions Tab's upper list, allowing
you to easily check for new episodes which display in the list on the lower part of the window, and
do several other things which we discuss here.
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=== 3.2.1 The Subscriptions Tab buttons from left to right

1)"Check for new podcast's". Clicking this first button will tell CastPodder to check all the Podcast
feeds you have listed (subscribed), for new Podcast Episodes.

2)"Catch-up". Clicking the second button tells CastPodder to only download the last new episodes
from the Podcast feeds you have subscribed to.

This is called "Catch-up" and a pop-up window will ask you whether you want to skip other
(previously available, not the latest) episodes you have not downloaded yet permanently or just this
once. This will force Catch-up to perform as you prescribed from then on. (You can change this
setting at a later time by going to the File / Preferences / General Tab).

3)"Add new feed" is the third button from the left. Click on it when you know the URL address to a
Podcast feed you wish to subscribe to. A pop-up window will open, and will prompt you to enter
the Feed's URL.

Make sure you are connected to the Internet and enter the Feed's URL in the URL box. Then click
on the "Save" button. CastPodder will check the feed and enter the Title automatically. Optionally
check and select in how many days after download episodes should be deleted.

4)"Remove selected feed" is the fourth button from the left (one with the red circle / white x) and it
will banish the Feed from your Subscriptions. This means CastPodder will not be able to check that
Podcast for content again, unless you subscribe to it again! It is important to notice that clicking on
an Episode in the lower list and then on the "Remove selected feed" button will delete the Entire
Feed and not that particular Episode. You can automatically delete Episodes which are older than
any given count of days using the next button (Properties).

5)"Properties" is the fifth button from the left and it will display a pop-up window with information
on the selected Feed 

The "Feed properties" allow you to make changes to the Podcast Feed's URL address if appropriate,
and if you check the option "Automatically delete episodes more than 14 days old" you can also
change the number of days CastPodder will wait before deleting old Episodes from that Podcast.

6)"Check / download selected feed" is the sixth button from the left, and if you click it CastPodder
will scan the selected feed for updates and start downloading new Episodes.

7)"Scheduler" is the final button in the series we are discussing and it provides you one-click access
to the CastPodder Scheduler

The Scheduler gives users a variety of options for setting CastPodder to automatically check Feeds
for new content and download them, at set times or regular intervals. This means you can either tell
CastPodder to check for new content at 3 different times during a 24 hour period, or you can set it
to check every so on, with options ranging from every 30 minutes to every 12 hours. If you would
like to play Podcast shows right after Scheduler has downloaded them, check the available option at
File / Preferences... / General Tab.

8)The text box next to the magnifying glass on the Subscriptions Tab, is a dynamic search box. This
means that as you enter a word, CastPodder will try to match it in Podcast Feeds you are subscribed
to and display them in the list below.
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=== 3.2.2 More controls for Podcast's listed in Subscriptions

Some of the functions discussed as accessible via the Subscription Tab's buttons are also available if
you right click on a Podcast Feed. A pop-up menu will appear, allowing you to Check and
download new Episodes from it, Remove it, open the local folder on your computer where content
from that Feed is stored at, or even open the Feed's URL with your web browser.

In the Episodes listing of a Podcast Feed, if you right click on an episode, another smaller pop-up
menu "Show Notes" will appear, allowing you to visit a web page with more information on that
particular Episode (such as a related blog post).

== 3.3 Podcast directory

The Podcast directory Tab displays a "folder tree" type listing of Podcast directories. Podcast
directories are where Podcast producers list their Feeds, much like a website owner would add her
website to an Internet website directory.

You can use these to find all kinds of interesting, popular or content specific Podcast shows for you
to subscribe to and get with CastPodder.

Also you can use the text box at the top of the Tab to add a Podcast directory's Feed which is not
currently among the preselected Feeds available in CastPodder.

The three available buttons allow to (from left to right) Refresh the contents of the directories, Open
all folders, and Close all folders.

To Open a particular directory's folder, simply click on it.

== 3.4 Cleanup

The Cleanup Tab allows you to clean up your system from all the clutter of Podcast shows you've
listened to in the past and are now just taking up valuable space.

You can select one of the Podcast Feeds you are subscribed to from the "Select a feed" drop-down
menu.

According to the checked options in the "Look for episodes in" box, CastPodder will search for
Episodes of that Feed in the "Player library" or / and the "Downloads folder". All Episodes found
there will be listed in the available box below.

Than you can manually check any Episodes you wish to clean up, or use the "Select all" button and
manually uncheck those you wish not to be disturbed by the Cleanup process.

You can also check the options "Delete library entries" or / and "Delete files" according to the type
of Cleanup (Delete) you wish to perform.
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== 3.5 Log (Optional)

The Log Tab displays technical information about what the CastPodder does when it is prompted by
the user to perform a task. It can be useful for troubleshooting or trying to establish whether a
particular Feed is not functioning as it should.

You can delete the contents of the Log Tab by clicking the "Clear" button. The text that displays in
the Log Tab's text box, can be Copied and Pasted as you do with any text on your computer.
However the contents of the Log Tab are produced automatically by CastPodder and text cannot be
entered there by the user.

Display of the Log Tab among the tabs of the main CastPodder window, is optional and can be
enabled by checking the available option at File / Preferences... / Advanced (tab) / "Show log tab in
application".

= 4. Setting Preferences

To open the "Preferences" window in CastPodder, which allows you to edit / set options for the
application, please click on File / Preferences...

The "Preferences" window will appear where you will see six different Tabs each containing
options for different parts of the CastPodder, giving you maximum control over how the application
works and how you enjoy your Podcast Receiving experience.

In this User Guide, we discuss each Tab and the options it provides the user with. Some of these
options you may have been prompted for before, within the CastPodder main window. Here you
can change or edit them.

== 4.1 General

The "General" Tab, allows you to set the General option relating to the CastPodder application. The
check boxes in the upper section of this tab, will make the statements next to them true if they are
checked by the user. 

There you can opt to have CastPodder do the following:

- At startup only show CastPodder in the system tray
The application stays minimized in a system tray CastPodder icon when it is started.

- Run a check for new podcast's when the application is started
Have CastPodder automatically check within your subscriptions for new content every time it is
started.

- Play downloads right after they're downloaded
CastPodder will automatically call on your chosen Player to start playing a newly downloaded
Podcast Episode.

- Check for new versions of the application at startup
This will allow CastPodder to check if a new version of the application is available for download.
This is better left checked as new versions may offer bug fixes and more functions.
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- Always use CastPodder for one-click subscription
Check this if you want CastPodder to catch Podcast Feeds available through one-click subscription
and it will allow you to subscribe to them with a single click.

- Catch-up skips older episodes permanently
If this is checked, every time you run "Catch-up" in the main Subscriptions Tab, any older than the
latest available Podcast Episodes you have not downloaded yet will be permanently skipped by
CastPodder.

- Continue running in the background when I close the main window
If this option is checked, every time you close the CastPodder window (either by the x button, File /
Close window, "Ctrl+w" or "Alt+F4") it will continue to work in the background and stay
minimized in an CastPodder icon in the system tray. To quit the application you would then need to
use File / Quit, Ctrl+q, or right click on the CastPodder system tray icon and select "Quit" from the
menu. To restore the CastPodder window from the system tray, right click on the icon and select
"Open CastPodder" or just double click.

=== 4.1.1 Location and storage management

On the lower part of the "General" Preferences Tab, are the "Location and storage management"
settings.

There you can set a minimal amount of available space on your hard drive that would trigger
CastPodder to stop downloading should it ever be reached. This is a nice protective measure against
absent mindedly having the free space on your hard drive all taken up by old Podcast Episodes.

Also you can choose the folder into which Podcast's will be downloaded. Remember, CastPodder
makes new folders automatically for each Podcast you download Episodes from. All these folder
and their content will be located where you indicate here. The default option is ~/iPodderData
folder.

== 4.2 Threading

The Threading Tab allows you to set a number for:

Maximal threads for feed scanning per session 
(Available options range between 1 and 16)

Maximal downloads per session
(Available options range between 1 and 6)

These setting can be very useful in improving download performance. If your bandwidth allows it
you can experiment by changing the defaults and seeing which setting works best for you.

Any changes you make to how multiple downloads are treated should be saved by clicking the
"Save" button on the Threading Tab.
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== 4.3 Network settings

On the "Network Settings" Tab you are given the option to use a proxy server with CastPodder. To
enable this option you must make sure the box next to "Use a proxy server" is checked and that you
enter the full URL address of the proxy server you want to use as well as the port number.

The other available option, in experimental use in CastPodder 2.1 is "Coralize URLs".
It is aimed at placing URLs in order.

== 4.4 Player

The "Player" Tab allows the user to pick between XMMS and Beep-Media-Player for the default
Player they want to play and manage synchronization of Podcast Episodes with.

Of course if you want to use one of the listed Players you must first have it installed on your
computer. If you want to use a different media manager / player, your best chance is to set the
option to "No player" and then CastPodder will check with your system for the default media player
you are using and use that.

== 4.5 Feed Manager

The "Feed Manager" Tab allows you to Synchronize your subscriptions to a remote service you
may be using to store the URLs to your favourite Podcast's (Such as in my.podnova.com)

Simply enter the full URL to the OPML file holding your favourite podcast's and it will
automatically be synchronize your CastPodder subscriptions to it.

A link to PodNova & GigaDial, are both on-line Feed Manager compatible with this CastPodder
feature is also provided in the form of a button.

== 4.6 Advanced

On the "Advanced" Tab of the "Preferences" window the ability for Power Users to run custom
commands after each download is given. The command's code is entered into the text box, and the
box next to "Run this command after each download" should be checked in order for it to execute.

Another available option is the "Show log tab in application". The Log Tab in the main CastPodder
window, offers valuable technical information about how CastPodder executes various tasks, and
what problems such as a corrupt Feed could be hindering a download. Although ineligible to the
uninitiated this Log output is of great use when troubleshooting or seeking expert advice.

= 5. Other Features

CastPodder boasts an easy to use, self explanatory user environment which is under continuous
watch for improvements. The more you use CastPodder, you will soon realize which of the several
paths, keyboard short cuts, you can use to do something best suits you. Some of the Features not
accessible via the CastPodder Tabs but only through the top drop-down menus are explained in this
section.

== 5.1 OPML Import / Export

CastPodder allows you to import your favourite Podcast Feeds from an OPML file you have stored
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locally on your computer. Alternatively you can also export your current subscription list on
another OPML file for backup purposes, or to use somewhere else.

=== 5.1.1 Importing an OPML File

1)Click on the "File" drop-down menu and select "Import feeds from opml..." (or you can try
holding down Ctrl+Shift+o on your keyboard while at the CastPodder main window)
2)From the "Select import file" window, locate the OPML file you wish to import to CastPodder on
your computer, and double click on it (or click once to select and then click on the "Open" button).

CastPodder will then import the OPML file you selected.

=== 5.1.2 Exporting an OPML File

1)Click on the "File" drop-down menu and select "Export feeds as opml..."
2)In the "Choose a name for the export file" window, enter the desired name for your OPML file, or
keep the default name which makes it easy to identify the file as containing your CastPodder
subscriptions. Also point to where you want the file to be saved.

CastPodder will then export the OPML file of the feeds in your Subscriptions and store it in the
location you have designated on your computer.

== 5.2 Language Change

If you would like to change the User Interface language of CastPodder to one of the many (more
than 15) different locales available, please do the following:

1)Click on Tools / Select language, and then on the language of your choice.
2)Restart CastPodder for the language file to be activated.

== 5.3 Update Checks

To manually check for a more recent version of the CastPodder application to the one you are using,
click on the "Help" drop-down menu and then choose "Check for Update..."

Keeping your software applications up to date is vital to maintaining an up to speed, safe and
enjoyable computer environment!

== 5.4 Placing Donations

Donations from satisfied users like yourself is what keeps the CastPodder project alive and
constantly improving. If you enjoy using CastPodder and you would like to  support its
development, one easy way to do that is by clicking on the "Help" drop-down menu, and then
selecting "Make a Donation".
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= 6. Walk Through's

Some people prefer to be guided step by step the first time they use something, such as a software
application. In this section of the User Guide you will find a series of walk-through's to some of the
essential functions of the CastPodder.

== 6.1 Subscribing to a Podcast

When you Subscribe to a Podcast with CastPodder, it checks for new Episodes on that Podcast and
makes it easy to discover and download them. Each Podcast publishes a news Feed in RSS or less
commonly Atom. You need to give CastPodder that Feed's address in order to Subscribe to it.

A Podcast's Feed URL (Address) is usually given on the web page where you discover a Podcast.
Look for a Feed's URL or a text or graphic link that says something like "RSS" or "Podcast Feed"
on it.

If the Podcast Feed's address is in the form of a link on a web page, right click on it on your web
browser and select "Copy Shortcut" on IE, or "Copy link location" on Firefox. Then you can paste
instead of typing it as described on step number 4.

Steps
1)Start CastPodder
2)With the CastPodder window open, press "Ctrl+N" on your keyboard or go to "Tools / Add a
Feed..."
3)An "Add a Feed" window pops up. In the URL text box, add the Feed's address (Not the website
address, the RSS or Atom address).
4)Click on the "Save" button.

That's it, CastPodder checks that Feed URL and if it is a valid Podcast Feed it will add it to your
Subscriptions so you can check and download Episodes from it.
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== 6.2 Downloading Podcast Episodes

Lets assume you are Subscribed with CastPodder on a number of Podcast's and you want to actually
get the shows brought to you. What do you do?

The following steps show you how to get the latest or all missed Episodes of a Podcast.

=== 6.2.1 Download most recent episodes

Steps
1)Start CastPodder
2)Go to the "Subscriptions" tab.
3)Click on the Catch-up button, or press F6 on your keyboard, or select "Tools / Catch-up"
4)In the pop-up window, select the option "Skip this time only" if you want to later be able to
download older Episodes from that Podcast with CastPodder.
5)Click on the OK button.

That's it! CastPodder will automatically check the Podcast's you are Subscribed to for new content
and start downloading them. If you don't wish to download new Episodes for all these Podcast's,
you can go to the "Downloads" tab, select the undesirable Podcast's and click on the "Cancel
selected download".

=== 6.2.2 Download all Episodes you don't have already

>From All Podcast's in your Subscriptions
Steps
1)Start CastPodder
2)Go to the "Subscriptions" tab.
3)Click on the "Check for new podcast's" button.

That's it! CastPodder will check all Feeds in your Subscriptions for new content and start
downloading them. All content since the last time you downloaded from a Podcast that is still
available will be downloaded.

>From A Selected Podcast in your Subscriptions
Steps
1)Start CastPodder
2)Go to the "Subscriptions" tab.
3)Click on the Podcast you want to check from the list, to select it.
4)Click on the "Check / Download selected feed" button.

That's it! CastPodder will check that particular Podcast Feed and download any Episodes from it
you haven't downloaded already.
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= 7. Guide Information

This User Guide is intended for users of the CastPodder software application on a compatible
Windows operating system. Some or all of the information contained herein only apply to the
versions of CastPodder for the Linux operating systems.

== 7.1 CastPodder Documentation

The CastPodder Documentation is an ongoing project, with changes and updates on a frequent
basis. If you would like to check for a more recent version of this User Guide, or the On-line
(constantly updated) version, please visit: 

CastPodder Documentation
http://www.castpodder.net/docs/

CastPodder On-line Documentation (CastPodderpedia)
http://wiki.castpodder.net/

More information and user support can also be found at:

CastPodder Support Forum
http://castpodder.phpbbweb.com/

== 7.2 Credits

The CastPodder Team
http://www.castpodder.net/team/

== 7.3 Errata Reporting

To report errors or omissions in this User Guide, please email sgrayban@castpodder.net

== 7.4 Documentation License

The CastPodder User Guide is part of the CastPodder Documentation, which is published under the
following Creative Commons License:

Creative Commons License: 

Attribution, Non Commercial, No Derivatives (by - nc - nd 2.5)

Back to the Table Of Contents

Author: Scott Grayban
Last Modified: 26/12/05 05:03:26

The Open Office2 versions of this file are  Digitally Signed
Get the Certificate bundle from the documentation website.

Master document is saved in OASIS OpenDocument Text for cross-platform portability.
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Appendix 1: GNU GPL License                                                                                            CastPodder  

GNU GENERAL PUBLIC LICENSE
Version 2, June 1991

 Copyright (C) 1989, 1991 Free Software Foundation, Inc.
 59 Temple Place, Suite 330, Boston, MA  02111-1307  USA
 Everyone is permitted to copy and distribute verbatim copies
 of this license document, but changing it is not allowed.

                    Preamble

  The licenses for most software are designed to take away your
freedom to share and change it.  By contrast, the GNU General Public
License is intended to guarantee your freedom to share and change free
software--to make sure the software is free for all its users.  This
General Public License applies to most of the Free Software
Foundation's software and to any other program whose authors commit to
using it.  (Some other Free Software Foundation software is covered by
the GNU Library General Public License instead.)  You can apply it to
your programs, too.

  When we speak of free software, we are referring to freedom, not
price.  Our General Public Licenses are designed to make sure that you
have the freedom to distribute copies of free software (and charge for
this service if you wish), that you receive source code or can get it
if you want it, that you can change the software or use pieces of it
in new free programs; and that you know you can do these things.

  To protect your rights, we need to make restrictions that forbid
anyone to deny you these rights or to ask you to surrender the rights.
These restrictions translate to certain responsibilities for you if you
distribute copies of the software, or if you modify it.

  For example, if you distribute copies of such a program, whether
gratis or for a fee, you must give the recipients all the rights that
you have.  You must make sure that they, too, receive or can get the
source code.  And you must show them these terms so they know their
rights.

  We protect your rights with two steps: (1) copyright the software, and
(2) offer you this license which gives you legal permission to copy,
distribute and/or modify the software.

  Also, for each author's protection and ours, we want to make certain
that everyone understands that there is no warranty for this free
software.  If the software is modified by someone else and passed on, we
want its recipients to know that what they have is not the original, so
that any problems introduced by others will not reflect on the original
authors' reputations.
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  Finally, any free program is threatened constantly by software
patents.  We wish to avoid the danger that redistributors of a free
program will individually obtain patent licenses, in effect making the
program proprietary.  To prevent this, we have made it clear that any
patent must be licensed for everyone's free use or not licensed at all.

  The precise terms and conditions for copying, distribution and
modification follow.

    GNU GENERAL PUBLIC LICENSE
   TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND MODIFICATION

  0. This License applies to any program or other work which contains
a notice placed by the copyright holder saying it may be distributed
under the terms of this General Public License.  The "Program", below,
refers to any such program or work, and a "work based on the Program"
means either the Program or any derivative work under copyright law:
that is to say, a work containing the Program or a portion of it,
either verbatim or with modifications and/or translated into another
language.  (Hereinafter, translation is included without limitation in
the term "modification".)  Each licensee is addressed as "you".

Activities other than copying, distribution and modification are not
covered by this License; they are outside its scope.  The act of
running the Program is not restricted, and the output from the Program
is covered only if its contents constitute a work based on the
Program (independent of having been made by running the Program).
Whether that is true depends on what the Program does.

  1. You may copy and distribute verbatim copies of the Program's
source code as you receive it, in any medium, provided that you
conspicuously and appropriately publish on each copy an appropriate
copyright notice and disclaimer of warranty; keep intact all the
notices that refer to this License and to the absence of any warranty;
and give any other recipients of the Program a copy of this License
along with the Program.

You may charge a fee for the physical act of transferring a copy, and
you may at your option offer warranty protection in exchange for a fee.

  2. You may modify your copy or copies of the Program or any portion
of it, thus forming a work based on the Program, and copy and
distribute such modifications or work under the terms of Section 1
above, provided that you also meet all of these conditions:

    a) You must cause the modified files to carry prominent notices
    stating that you changed the files and the date of any change.

    b) You must cause any work that you distribute or publish, that in
    whole or in part contains or is derived from the Program or any
    part thereof, to be licensed as a whole at no charge to all third
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    parties under the terms of this License.

    c) If the modified program normally reads commands interactively
    when run, you must cause it, when started running for such
    interactive use in the most ordinary way, to print or display an
    announcement including an appropriate copyright notice and a
    notice that there is no warranty (or else, saying that you provide
    a warranty) and that users may redistribute the program under
    these conditions, and telling the user how to view a copy of this
    License.  (Exception: if the Program itself is interactive but
    does not normally print such an announcement, your work based on
    the Program is not required to print an announcement.)

These requirements apply to the modified work as a whole.  If
identifiable sections of that work are not derived from the Program,
and can be reasonably considered independent and separate works in
themselves, then this License, and its terms, do not apply to those
sections when you distribute them as separate works.  But when you
distribute the same sections as part of a whole which is a work based
on the Program, the distribution of the whole must be on the terms of
this License, whose permissions for other licensees extend to the
entire whole, and thus to each and every part regardless of who wrote it.

Thus, it is not the intent of this section to claim rights or contest
your rights to work written entirely by you; rather, the intent is to
exercise the right to control the distribution of derivative or
collective works based on the Program.

In addition, mere aggregation of another work not based on the Program
with the Program (or with a work based on the Program) on a volume of
a storage or distribution medium does not bring the other work under
the scope of this License.

  3. You may copy and distribute the Program (or a work based on it,
under Section 2) in object code or executable form under the terms of
Sections 1 and 2 above provided that you also do one of the following:

    a) Accompany it with the complete corresponding machine-readable
    source code, which must be distributed under the terms of Sections
    1 and 2 above on a medium customarily used for software interchange; or,

    b) Accompany it with a written offer, valid for at least three
    years, to give any third party, for a charge no more than your
    cost of physically performing source distribution, a complete
    machine-readable copy of the corresponding source code, to be
    distributed under the terms of Sections 1 and 2 above on a medium
    customarily used for software interchange; or,

    c) Accompany it with the information you received as to the offer
    to distribute corresponding source code.  (This alternative is
    allowed only for noncommercial distribution and only if you
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    received the program in object code or executable form with such
    an offer, in accord with Subsection b above.)

The source code for a work means the preferred form of the work for
making modifications to it.  For an executable work, complete source
code means all the source code for all modules it contains, plus any
associated interface definition files, plus the scripts used to
control compilation and installation of the executable.  However, as a
special exception, the source code distributed need not include
anything that is normally distributed (in either source or binary
form) with the major components (compiler, kernel, and so on) of the
operating system on which the executable runs, unless that component
itself accompanies the executable.

If distribution of executable or object code is made by offering
access to copy from a designated place, then offering equivalent
access to copy the source code from the same place counts as
distribution of the source code, even though third parties are not
compelled to copy the source along with the object code.

  4. You may not copy, modify, sublicense, or distribute the Program
except as expressly provided under this License.  Any attempt
otherwise to copy, modify, sublicense or distribute the Program is
void, and will automatically terminate your rights under this License.
However, parties who have received copies, or rights, from you under
this License will not have their licenses terminated so long as such
parties remain in full compliance.

  5. You are not required to accept this License, since you have not
signed it.  However, nothing else grants you permission to modify or
distribute the Program or its derivative works.  These actions are
prohibited by law if you do not accept this License.  Therefore, by
modifying or distributing the Program (or any work based on the
Program), you indicate your acceptance of this License to do so, and
all its terms and conditions for copying, distributing or modifying
the Program or works based on it.

  6. Each time you redistribute the Program (or any work based on the
Program), the recipient automatically receives a license from the
original licensor to copy, distribute or modify the Program subject to
these terms and conditions.  You may not impose any further
restrictions on the recipients' exercise of the rights granted herein.
You are not responsible for enforcing compliance by third parties to
this License.

  7. If, as a consequence of a court judgement or allegation of patent
infringement or for any other reason (not limited to patent issues),
conditions are imposed on you (whether by court order, agreement or
otherwise) that contradict the conditions of this License, they do not
excuse you from the conditions of this License.  If you cannot
distribute so as to satisfy simultaneously your obligations under this
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License and any other pertinent obligations, then as a consequence you
may not distribute the Program at all.  For example, if a patent
license would not permit royalty-free redistribution of the Program by
all those who receive copies directly or indirectly through you, then
the only way you could satisfy both it and this License would be to
refrain entirely from distribution of the Program.

If any portion of this section is held invalid or unenforceable under
any particular circumstance, the balance of the section is intended to
apply and the section as a whole is intended to apply in other
circumstances.

It is not the purpose of this section to induce you to infringe any
patents or other property right claims or to contest validity of any
such claims; this section has the sole purpose of protecting the
integrity of the free software distribution system, which is
implemented by public license practices.  Many people have made
generous contributions to the wide range of software distributed
through that system in reliance on consistent application of that
system; it is up to the author/donor to decide if he or she is willing
to distribute software through any other system and a licensee cannot
impose that choice.

This section is intended to make thoroughly clear what is believed to
be a consequence of the rest of this License.

  8. If the distribution and/or use of the Program is restricted in
certain countries either by patents or by copyrighted interfaces, the
original copyright holder who places the Program under this License
may add an explicit geographical distribution limitation excluding
those countries, so that distribution is permitted only in or among
countries not thus excluded.  In such case, this License incorporates
the limitation as if written in the body of this License.

  9. The Free Software Foundation may publish revised and/or new versions
of the General Public License from time to time.  Such new versions will
be similar in spirit to the present version, but may differ in detail to
address new problems or concerns.

Each version is given a distinguishing version number.  If the Program
specifies a version number of this License which applies to it and "any
later version", you have the option of following the terms and conditions
either of that version or of any later version published by the Free
Software Foundation.  If the Program does not specify a version number of
this License, you may choose any version ever published by the Free Software
Foundation.

  10. If you wish to incorporate parts of the Program into other free
programs whose distribution conditions are different, write to the author
to ask for permission.  For software which is copyrighted by the Free
Software Foundation, write to the Free Software Foundation; we sometimes
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make exceptions for this.  Our decision will be guided by the two goals
of preserving the free status of all derivatives of our free software and
of promoting the sharing and reuse of software generally.
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    NO WARRANTY

  11. BECAUSE THE PROGRAM IS LICENSED FREE OF CHARGE, THERE IS NO WARRANTY
FOR THE PROGRAM, TO THE EXTENT PERMITTED BY APPLICABLE LAW.  EXCEPT WHEN
OTHERWISE STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR OTHER PARTIES
PROVIDE THE PROGRAM "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED
OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE.  THE ENTIRE RISK AS
TO THE QUALITY AND PERFORMANCE OF THE PROGRAM IS WITH YOU.  SHOULD THE
PROGRAM PROVE DEFECTIVE, YOU ASSUME THE COST OF ALL NECESSARY SERVICING,
REPAIR OR CORRECTION.

  12. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING
WILL ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY MODIFY AND/OR
REDISTRIBUTE THE PROGRAM AS PERMITTED ABOVE, BE LIABLE TO YOU FOR DAMAGES,
INCLUDING ANY GENERAL, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING
OUT OF THE USE OR INABILITY TO USE THE PROGRAM (INCLUDING BUT NOT LIMITED
TO LOSS OF DATA OR DATA BEING RENDERED INACCURATE OR LOSSES SUSTAINED BY
YOU OR THIRD PARTIES OR A FAILURE OF THE PROGRAM TO OPERATE WITH ANY OTHER
PROGRAMS), EVEN IF SUCH HOLDER OR OTHER PARTY HAS BEEN ADVISED OF THE
POSSIBILITY OF SUCH DAMAGES.

                     END OF TERMS AND CONDITIONS

 Copyright 2005 CastPodder Team

 This program is free software; you can redistribute it and/or modify
 it under the terms of the GNU General Public License as published by
 the Free Software Foundation; either version 2 of the License, or
 (at your option) any later version.

 This program is distributed in the hope that it will be useful,
 but WITHOUT ANY WARRANTY; without even the implied warranty of
 MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE.  See the
 GNU General Public License for more details.

 You should have received a copy of the GNU General Public License
 along with this program; if not, write to the Free Software
 Foundation, Inc., 59 Temple Place, Suite 330, Boston, MA  02111-1307  USA
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Appendix 2: Creative Commons Attribution-NonCommercial-NoDerivs 2.5 License         CastPodder  

Attribution-NonCommercial-NoDerivs 2.5

CREATIVE COMMONS CORPORATION IS NOT A LAW FIRM AND DOES NOT PROVIDE
LEGAL SERVICES. DISTRIBUTION OF THIS LICENSE DOES NOT CREATE AN
ATTORNEY-CLIENT RELATIONSHIP. CREATIVE COMMONS PROVIDES THIS
INFORMATION ON AN "AS-IS" BASIS. CREATIVE COMMONS MAKES NO WARRANTIES
REGARDING THE INFORMATION PROVIDED, AND DISCLAIMS LIABILITY FOR
DAMAGES RESULTING FROM ITS USE.

License 

THE WORK (AS DEFINED BELOW) IS PROVIDED UNDER THE TERMS OF THIS
CREATIVE COMMONS PUBLIC LICENSE ("CCPL" OR "LICENSE"). THE WORK IS
PROTECTED BY COPYRIGHT AND/OR OTHER APPLICABLE LAW. ANY USE OF THE
WORK OTHER THAN AS AUTHORIZED UNDER THIS LICENSE OR COPYRIGHT LAW IS
PROHIBITED. 

BY EXERCISING ANY RIGHTS TO THE WORK PROVIDED HERE, YOU ACCEPT AND
AGREE TO BE BOUND BY THE TERMS OF THIS LICENSE. THE LICENSOR GRANTS
YOU THE RIGHTS CONTAINED HERE IN CONSIDERATION OF YOUR ACCEPTANCE OF
SUCH TERMS AND CONDITIONS. 

1. Definitions 

a. "Collective Work" means a work, such as a periodical issue, anthology or encyclopedia, in
which the Work in its entirety in unmodified form, along with a number of other
contributions, constituting separate and independent works in themselves, are assembled into
a collective whole. A work that constitutes a Collective Work will not be considered a
Derivative Work (as defined below) for the purposes of this License. 

b. "Derivative Work" means a work based upon the Work or upon the Work and other pre-
existing works, such as a translation, musical arrangement, dramatization, fictionalization,
motion picture version, sound recording, art reproduction, abridgment, condensation, or any
other form in which the Work may be recast, transformed, or adapted, except that a work
that constitutes a Collective Work will not be considered a Derivative Work for the purpose
of this License. For the avoidance of doubt, where the Work is a musical composition or
sound recording, the synchronization of the Work in timed-relation with a moving image
("synching") will be considered a Derivative Work for the purpose of this License. 

c. "Licensor" means the individual or entity that offers the Work under the terms of this
License. 

d. "Original Author" means the individual or entity who created the Work. 
e. "Work" means the copyrightable work of authorship offered under the terms of this

License. 
f. "You" means an individual or entity exercising rights under this License who has not

previously violated the terms of this License with respect to the Work, or who has received
express permission from the Licensor to exercise rights under this License despite a previous
violation. 
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2. Fair Use Rights. Nothing in this license is intended to reduce, limit, or restrict any rights arising
from fair use, first sale or other limitations on the exclusive rights of the copyright owner under
copyright law or other applicable laws. 

3. License Grant. Subject to the terms and conditions of this License, Licensor hereby grants You a
worldwide, royalty-free, non-exclusive, perpetual (for the duration of the applicable copyright)
license to exercise the rights in the Work as stated below: 

a. to reproduce the Work, to incorporate the Work into one or more Collective Works, and to
reproduce the Work as incorporated in the Collective Works; 

b. to distribute copies or phonorecords of, display publicly, perform publicly, and perform
publicly by means of a digital audio transmission the Work including as incorporated in
Collective Works; 

The above rights may be exercised in all media and formats whether now known or hereafter
devised. The above rights include the right to make such modifications as are technically necessary
to exercise the rights in other media and formats, but otherwise you have no rights to make
Derivative Works. All rights not expressly granted by Licensor are hereby reserved, including but
not limited to the rights set forth in Sections 4(d) and 4(e).

4. Restrictions.The license granted in Section 3 above is expressly made subject to and limited by
the following restrictions: 

a. You may distribute, publicly display, publicly perform, or publicly digitally perform the
Work only under the terms of this License, and You must include a copy of, or the Uniform
Resource Identifier for, this License with every copy or phonorecord of the Work You
distribute, publicly display, publicly perform, or publicly digitally perform. You may not
offer or impose any terms on the Work that alter or restrict the terms of this License or the
recipients' exercise of the rights granted hereunder. You may not sublicense the Work. You
must keep intact all notices that refer to this License and to the disclaimer of warranties. You
may not distribute, publicly display, publicly perform, or publicly digitally perform the
Work with any technological measures that control access or use of the Work in a manner
inconsistent with the terms of this License Agreement. The above applies to the Work as
incorporated in a Collective Work, but this does not require the Collective Work apart from
the Work itself to be made subject to the terms of this License. If You create a Collective
Work, upon notice from any Licensor You must, to the extent practicable, remove from the
Collective Work any credit as required by clause 4(c), as requested. 

b. You may not exercise any of the rights granted to You in Section 3 above in any manner that
is primarily intended for or directed toward commercial advantage or private monetary
compensation. The exchange of the Work for other copyrighted works by means of digital
file-sharing or otherwise shall not be considered to be intended for or directed toward
commercial advantage or private monetary compensation, provided there is no payment of
any monetary compensation in connection with the exchange of copyrighted works. 

c. If you distribute, publicly display, publicly perform, or publicly digitally perform the Work,
You must keep intact all copyright notices for the Work and provide, reasonable to the
medium or means You are utilizing: (i) the name of the Original Author (or pseudonym, if
applicable) if supplied, and/or (ii) if the Original Author and/or Licensor designate another
party or parties (e.g. a sponsor institute, publishing entity, journal) for attribution in
Licensor's copyright notice, terms of service or by other reasonable means, the name of such
party or parties; the title of the Work if supplied; and to the extent reasonably practicable,
the Uniform Resource Identifier, if any, that Licensor specifies to be associated with the
Work, unless such URI does not refer to the copyright notice or licensing information for the
Work. Such credit may be implemented in any reasonable manner; provided, however, that
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in the case of a Collective Work, at a minimum such credit will appear where any other
comparable authorship credit appears and in a manner at least as prominent as such other
comparable authorship credit. 

d. For the avoidance of doubt, where the Work is a musical composition:

i. Performance Royalties Under Blanket Licenses. Licensor reserves the exclusive
right to collect, whether individually or via a performance rights society (e.g.
ASCAP, BMI, SESAC), royalties for the public performance or public digital
performance (e.g. webcast) of the Work if that performance is primarily intended for
or directed toward commercial advantage or private monetary compensation. 

e. Mechanical Rights and Statutory Royalties. Licensor reserves the exclusive right to
collect, whether individually or via a music rights agency or designated agent (e.g. Harry
Fox Agency), royalties for any phonorecord You create from the Work ("cover version")
and distribute, subject to the compulsory license created by 17 USC Section 115 of the US
Copyright Act (or the equivalent in other jurisdictions), if Your distribution of such cover
version is primarily intended for or directed toward commercial advantage or private
monetary compensation.

f. Webcasting Rights and Statutory Royalties. For the avoidance of doubt, where the Work
is a sound recording, Licensor reserves the exclusive right to collect, whether individually or
via a performance-rights society (e.g. SoundExchange), royalties for the public digital
performance (e.g. webcast) of the Work, subject to the compulsory license created by 17
USC Section 114 of the US Copyright Act (or the equivalent in other jurisdictions), if Your
public digital performance is primarily intended for or directed toward commercial
advantage or private monetary compensation. 

5. Representations, Warranties and Disclaimer

UNLESS OTHERWISE MUTUALLY AGREED BY THE PARTIES IN WRITING, LICENSOR
OFFERS THE WORK AS-IS AND MAKES NO REPRESENTATIONS OR WARRANTIES OF
ANY KIND CONCERNING THE WORK, EXPRESS, IMPLIED, STATUTORY OR
OTHERWISE, INCLUDING, WITHOUT LIMITATION, WARRANTIES OF TITLE,
MERCHANTIBILITY, FITNESS FOR A PARTICULAR PURPOSE, NONINFRINGEMENT, OR
THE ABSENCE OF LATENT OR OTHER DEFECTS, ACCURACY, OR THE PRESENCE OF
ABSENCE OF ERRORS, WHETHER OR NOT DISCOVERABLE. SOME JURISDICTIONS DO
NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES, SO SUCH EXCLUSION MAY
NOT APPLY TO YOU.

6. Limitation on Liability. EXCEPT TO THE EXTENT REQUIRED BY APPLICABLE LAW,
IN NO EVENT WILL LICENSOR BE LIABLE TO YOU ON ANY LEGAL THEORY FOR ANY
SPECIAL, INCIDENTAL, CONSEQUENTIAL, PUNITIVE OR EXEMPLARY DAMAGES
ARISING OUT OF THIS LICENSE OR THE USE OF THE WORK, EVEN IF LICENSOR HAS
BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. 

7. Termination 

a. This License and the rights granted hereunder will terminate automatically upon any breach
by You of the terms of this License. Individuals or entities who have received Collective
Works from You under this License, however, will not have their licenses terminated
provided such individuals or entities remain in full compliance with those licenses. Sections
1, 2, 5, 6, 7, and 8 will survive any termination of this License. 

b. Subject to the above terms and conditions, the license granted here is perpetual (for the
duration of the applicable copyright in the Work). Notwithstanding the above, Licensor
reserves the right to release the Work under different license terms or to stop distributing the
Work at any time; provided, however that any such election will not serve to withdraw this
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License (or any other license that has been, or is required to be, granted under the terms of
this License), and this License will continue in full force and effect unless terminated as
stated above. 

8. Miscellaneous 

a. Each time You distribute or publicly digitally perform the Work or a Collective Work, the
Licensor offers to the recipient a license to the Work on the same terms and conditions as
the license granted to You under this License. 

b. If any provision of this License is invalid or unenforceable under applicable law, it shall not
affect the validity or enforceability of the remainder of the terms of this License, and without
further action by the parties to this agreement, such provision shall be reformed to the
minimum extent necessary to make such provision valid and enforceable. 

c. No term or provision of this License shall be deemed waived and no breach consented to
unless such waiver or consent shall be in writing and signed by the party to be charged with
such waiver or consent. 

d. This License constitutes the entire agreement between the parties with respect to the Work
licensed here. There are no understandings, agreements or representations with respect to the
Work not specified here. Licensor shall not be bound by any additional provisions that may
appear in any communication from You. This License may not be modified without the
mutual written agreement of the Licensor and You. 

Creative Commons is not a party to this License, and makes no warranty whatsoever in connection
with the Work. Creative Commons will not be liable to You or any party on any legal theory for any
damages whatsoever, including without limitation any general, special, incidental or consequential
damages arising in connection to this license. Notwithstanding the foregoing two (2) sentences, if
Creative Commons has expressly identified itself as the Licensor hereunder, it shall have all rights
and obligations of Licensor. 

Except for the limited purpose of indicating to the public that the Work is licensed under the CCPL,
neither party will use the trademark "Creative Commons" or any related trademark or logo of
Creative Commons without the prior written consent of Creative Commons. Any permitted use will
be in compliance with Creative Commons' then-current trademark usage guidelines, as may be
published on its website or otherwise made available upon request from time to time.

Creative Commons may be contacted at http://creativecommons.org/.
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